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1 Overview 
Speco Technologies SecureGuard ™ is a PC Windows application that provides access to multiple DVRs, 

NVRs, and IP cameras in order to assist surveillance personnel. This document provides information 

intended to be useful to users of the system. 

This document addresses topics in the following areas: 

1. Installation – How to install the product on one or more systems. 

2. Configuration – Describes what needs to be done before active surveillance work can be 

performed. This work is typically done by an administrator or installer. 

3. Normal Operation – Describes the functions available during normal operation of the product. 

The SecureGuard™ product uses a modular design where the connections to different types of IP 

cameras, DVRs, and NVRs are made. Each connection plug-in provides access to a different type or 

family of devices. The operations available on each DVR, NVR, or IP camera may vary, depending on 

what level of support the connection plug-in is able to provide. 

2 Installation 

2.1 System Requirements 

The SecureGuard™ product is intended for systems with the following types of operating systems: 

1. Windows 7 Professional.  The system should have at least 4G of memory. (32-bit or 64-bit) 

The monitor screen resolution should be at least 1280 x 800. 

2.2 System Installation 

The product is delivered in a self-extracting executable. Simply run the executable to install the 

program. In most cases, it is highly recommended to use the defaults provided for where to install the 

product and which components to install. 

2.3 Command Line Options 

A command line option can be specified when starting the SecureGuard™ Client. This option makes it 

possible to create a convenient shortcut. The option is described in Table 1. 

Table 1 - Command Line Options 

Option Description 

/user=name Specifies the user name that should appear in the initial login box. 

 

The option can be in upper or lower case.  
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Normally, the user name in the initial login is the same as the name specified when the Client was last 

run. This option lets you override this value.  

The effect of using these command line options is listed below in Table 2. 

Table 2 - Command Line Option Effects 

Command Line Description 

/user=William User name  

3 Configuration 
SecureGuard™ provides controlled access through use of user names and passwords. There is one 

special user who will be referred to as the Administrator or Installer. The administrator is typically the 

one who performs the initial configuration on the installed product. This includes: 

1. System Configuration - Adding new DVR, NVR, and IP camera sites to the system.  

2. User Configuration - Adding new users to the system, providing access so they may monitor the 

surveillance equipment. 

 

3.1 Concepts 

3.1.1 Users 

A user in SecureGuard™ consists of a name, password, and a role. A role is a set of permissions for 

different operations which determine what the user can and cannot do. When the application is started, 

the user is asked for a user login name and password. If these match what the administrator has 

configured, then the product initializes and the user can perform various operations.  

There is a special user named admin who is the administrator for the system. This user is always present 

in the list of users and cannot be deleted or modified. All other users are added by the administrator and 

may or may not have non-blank passwords. The Administrator has permission to do everything within 

the system. In addition, the administrator may also delegate an operation to other users so that they 

can perform the operation.  

3.1.2 System Folder 

The System Folder is the location in the file system where all the settings and configuration information 

is stored. This location should be on a local hard drive. 

3.1.3 Multiple Instances 

On a single system, a user can run multiple copies of SecureGuard™ using the same login information. 

Typically, multiple instances are used to connect to one group of DVRs, NVRS, or IP cameras on one 

monitor, with another set displayed on a separate monitor.  
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3.1.4 SecureGuard™ Configuration Tool 

SecureGuard™ encapsulates administrator responsibilities within the Configuration Tool, which will be 

shown directly after the installation steps above.   The interface to this function is a tabular display 

intended to guide administrators through the steps of creating and maintaining interactions with 

cameras and users.    

3.1.5 SecureGuard™ Client 

General users of SecureGuard™ will use the Client to create display groups of cameras and monitor 

audio and video information.    

3.1.6 Initial Login 

With the first installation, the SecureGuard™ system will need to be initialized.  You will be presented 

with the following dialog: 

                                 

Figure 1 – New Configuration 

By selecting Yes (the preferred option), the Configuration Tool will automatically create all system 

folders in the default locations.  Selecting No will allow the user to manually organize the storage of the 

application data. 

Subsequent installations of the SecureGuard™ system will not show this prompt, and instead will install 

the software around existing data.  

3.2 SecureGuard™ Configuration Tool 

The SecureGuard™ system consists of information that often needs to be specified only once by the 

Administrator. This includes  

1. Location of the System Folder and recording data, and the maintenance parameters for this 

data. 

2. Initialization of a database to manage recording information 

3. Access to network settings for communications with IP cameras, DVRs, and NVRs used 

4. Configuration of DVR, NVR, and IP camera sites  

5. Recording schedule management 

6. User logins and roles 

7. Activity logs 
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3.2.1 Upgrading to SecureGuard™  

If you are upgrading to SecureGuard™ from SecureGuard™, the Configuration Tool attempts to locate 

and import existing configuration information.  Previous recordings obtained using SecureGuard™ will 

not be imported and should be archived prior to the upgrade.   

                                

 

3.2.2 System Configuration 

The first dialog shown in the Configuration Tool is the System dialog.  In this step, the administrator 

selects data locations and maintenance parameters for the system. 

 

Figure 2 - System Configuration 

The default settings will provide adequate performance for most installations.  Storage of recordings 

requires ample disk space however, so for optimal performance it is recommended that system data not 
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be located on the same drive as the operating system.   Recorded data will be deleted as needed to keep 

usage below the maximum limit selected. 

On each tab of the Configuration Tool, there is an Apply button.  The Apply button is enabled when 

changes have been made that need to be stored to the database. Trying to move to a different tab 

without pressing the Apply button will cause a dialog to appear asking if you want to save the changed 

settings. An example of this dialog is shown below. 

                                                    

Figure 3 - Apply dialog 

Once all updated information has been written to the database, the underlying service needs to be 

stopped and restarted so that the database is refreshed.  These actions will happen automatically when 

exiting the Configuration Tool.  Administrators may also do this manually by using the Stop and Manual 

Start buttons located on the bottom of the System page. 

3.2.3 Database Configuration 

The SecureGuard™ system uses a database to organize users and recordings.  When doing a manual 

installation of SecureGuard™, click the “Create New” button to initialize this database with default 

settings. 
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Figure 4 - Database Configuration 

SecureGuard™ provides the ability to store and retrieve configuration information from the system.     

• Export – Configuration settings for the current installation (e.g.  site information, users, groups, 

etc.)  are bundled into a single .sgz file that may be used on other PCs to initialize a system.  

Recording information and recordings will not be collected. 

• Import – An .sgz file will be used to populate data in the system locations provided.  If existing 

system data is present in these locations, the user will be notified.  Recordings cannot be 

imported. 

• Migrate – If a previous installation of SecureGuard™ is present on the PC, configuration settings 

can be imported into SecureGuard™.  Recordings will not be imported. 

 

3.2.4 Network Configuration 

Network settings for your environment will prefill within the Network dialog.   Though wireless 

interfaces may appear as options in the Client and Video Interface selection boxes, it is strongly advised 

to select a Local Area Network interface instead.   

 

Figure 5 - Network Configuration 

The Speco DDNS service is used to keep a domain name pointing to the same computer or server even 

though the IP address for it may change.  To register your SecureGuard™ server with the Speco DDNS 

service, click the Enable Speco DDNS checkbox on the network tab.  Enter the desired hostname and (if 
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necessary) the DDNS port to use.  If Use Server Port is checked, the server port will be used. You only 

need to change these values if you are behind an internet gateway.  Check with your network 

administrator if you are unsure. 

Pressing the submit/update button will attempt to register your server using the name specified and the 

hardware (mac) address of the client interface selected above.   Once enabled, the server will 

periodically update its information with the Speco DDNS server. 

 

3.2.5 Site Configuration 

A site refers to a DVR, NVR, or an IP camera.   Use the Sites dialog to configure connections to these 

devices. 

  

Figure 6 - Sites Configuration 

3.2.5.1 Site Maintenance 

The following site operations are available: 

1. Site Locate - An easy way to locate and add sites for IP cameras on your local network is to use 

the “Site Locate…” button. This function helps automate the creation of site objects for local IP 

cameras. Pressing the button brings up a dialog as shown below. 
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Figure 7 - Site Locate dialog 

This function scans the local network for IP cameras and displays information about these 

cameras in table format.  The information includes the name, IP address, RTSP port number, and 

the MAC address. 

 

The table at left shows existing sites found. To add any of these sites to the configuration, 

double click the entry. This opens the Site Settings dialog (below) with many of the required 

entries prefilled. Change the site name, and then enter the user name and password, and any 

other required information (see example below). Once the site is fully defined, click OK to 

complete the action. 

 

Note:  if no IP cameras are found, check that the Client and Video Interfaces selected on the 

Network tab are set to the local area network. 

 

2. New - To add a new site, do the following: 

a. Click the New button.  This opens a Site Settings dialog, examples of which are shown 

below. 
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Figure 8- Site Settings dialog 

b. In the Site Settings, enter a new name for the site. All site names in the Sites list must be 

unique. 

c. Select the appropriate Type of device. 

d. Select the Model for the site. If you do not see the correct model in the Model list 

shown, scroll up or down to see additional choices. 

e. Enter the remaining site arguments. Note that the settings may be slightly different for 

each Model. 

f. When defining a site for an HD, RS, WRS, DS, NS, ZS and HS model DVRs and NVRs, you 

must manually specify which cameras have PTZ capability. The Site Settings dialog has a 

number of checkboxes that can be checked to indicate which cameras are PTZ. 

g. When defining a site with both high and low definition video, select the appropriate 

stream for each. 

h. Additional audio settings are provided for IP Cameras only. 

i. Click Check Site to test the connection to the new site and view settings. Click the Fix 

button to synchronize local settings with actual device settings. 
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3. Edit - Update an existing site. Select the site you wish to change in the Sites list and press the 

Edit button. You can also double-click on the site in the site list. This opens the Site Settings 

dialog to make changes to the site connection information.  

The following additional functions are available by selecting a site in the Sites list then pressing the right 

mouse button to show the available options below: 

• Delete - A pop-up is displayed to confirm the action. Deleting a site should be a rare action. 

 

• Duplicate – Within an environment, there may be multiple site entries for the same physical site 

with slight differences such as Username and password. This function creates a new site item 

with the same parameters as the original. Edit the site to modify any parameters. 

 

• Rename – Enter a new name in the location provided. Sites may also be renamed using the Edit 

button. 

 

• Enable –This action enables users to view or record information from the site. 

 

• Configuration – This action initiates an external connection to the remote site to update its 

configuration.  The browser and subsequent controls vary depending on the site type selected.  

The Administrator will need to enter the appropriate login and password to connect to these 

site controls. 

3.2.6 Schedule Configuration 

Sites can be set up for automatic recording using the Schedule tab.  SecureGuard™ provides the 

capability for Continuous recording as well as Motion and Sensor recording when configured within the 

site.    These recording actions are defined as follows: 

• Continuous – uninterrupted recording on an hour by hour basis 

• Motion – motion-triggered video detected and reported by the site 

• Sensor – sensor-triggered video detected and reported by the site 

An example of the Schedule tab is shown below. 
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Figure 9 - Schedule Configuration 

At the bottom of the dialog on the left is a list of all Sites configured in the system.  On the right will be 

the Sites associated with the Schedule shown.  Sites may only be used in one Schedule at a time. Those 

in use are displayed with a checked box and the name of the Schedule it is associated with.    

Colors are used to represent 1-hour blocks of time when different recording types will take place.  First 

select the recording Action type then use the mouse to paint the grid in the appropriate time block(s).  

Use Clear to remove recording Actions on individual time blocks, or the Clear All button to clear the 

entire time grid. 

3.2.6.1 Schedule Maintenance 

The following Schedule operations are available: 

1. Creation and Maintenance –To select an Available Site for use in this schedule, click the 

“>>>” button.  To remove a Site from the schedule, use the “<<<” button.    

 

2. New – To create a new schedule, select the New button and enter a new schedule name.  A 

blank grid will be provided. 

 

3. Rename – To rename a schedule, select the Rename button and enter a new name for the 

Schedule shown. 
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4. Copy –To copy the schedule shown, select the Copy button and update the name for the 

new Schedule. 

 

5. Delete – To remove a Schedule and deallocate all Sites associates with it, use the Delete 

button. 

3.2.7 User Configuration 

The list of Users and Roles is managed through the User Configuration dialog. Three Login Ids are 

predefined in the system:  admin, user and guest.  

 

Figure 10 - User Configuration 

• User Id – This field is assigned by the system and is unique and unchangeable for each user. 

• Login Id – This is the login ID used to access the system. 

• Role – provides a summary of permissions available 

• Name – gives a detailed name for the person 

• Email –contact information 

3.2.7.1 Adding a new user 

To add a user to the SecureGuard™ system, use the Add User button. This will open a dialog as shown 

below. Enter information in the fields provided then click OK. 
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Figure 11 - Add User dialog 

3.2.7.2 Deleting an existing user 

To delete an existing user, click on the appropriate row of the table and select the Delete button. You 

will be asked to verify the action before it is completed. 

3.2.7.3 Updating Information for an Existing User 

To modify an existing user, double-click a row of the Users table shown. This will open the Update User 

dialog as shown below. This dialog can be used to change the password, role, name, or email for the 

user. The Login ID cannot be changed.  The Role of the ‘admin’ login also may not be changed. 

                

Figure 12 -Update User dialog 

3.2.7.4 Roles Management 

To manage the available permissions in the system, click the Roles button on the Users tab. This opens 

the Roles Management dialog as shown below. This dialog shows a table with the list of available 

permissions, and how these are set for each role.  
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Figure 13 -Roles Management dialog 
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3.2.7.5 Role Maintenance 

1. Add a new Role 

 

To define a new role, click the Add Role button. This opens the Add Role dialog shown below.  Specify a 

Name for the new role. In addition, you can select an existing role to be used to initialize the new role 

information. This essentially allows you copy an existing role and modify only a few permissions rather 

than all of them.  

                 

Figure 14 - Add Role dialog 

2. Update or delete an existing Role 

To update or delete an existing Role, double-click on the Role Name at the top of a column in the Roles 

Management table.  This opens an Update Role dialog as shown below. Use the options provided to 

rename or delete the role.   Only Roles that are not assigned to any user can be deleted.  You will be 

asked to verify the action before it is completed. 

            

Figure 15 - Update Role dialog 
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3.2.8 Logs  

An application Activity log is kept to record high-level actions that affect the SecureGuard™ 

configuration or the settings on a particular IP camera, DVR, or NVR. The log can be viewed to review 

recent activity.   Logs provided under the “Server Logs” tab are strictly for Speco Tech support, but can 

be viewed by clicking one of the time-stamped files then the Open button. 

 

Figure 16 - Configuration Tool Logs 

 

3.2.9 IP Scanner Tool 

 

Select IP Scanner from the toolbar to launch an application which allows you to conveniently configure 

IP cameras. 

Note: when running this tool, if no cameras are found, verify there is only one active network adapter 

for the PC to aid operation (see Network tab). 
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4 General Operation 

4.1 Login 

At startup, the system will request login information.  Enter the assigned user name and password.  If 

the Auto Connect box is checked, the previously configured start group of sites will load and 

automatically connect for Live viewing.  

                                                

Figure 17 - Login dialog 

4.2 SecureGuard™ Client 

The general layout of the SecureGuard™ Client is provided below.  
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Figure 18 - General Layout 

The different parts of the client window are as follows: 

1. Main menu – see Main Menu 

2. Toolbar –see Main Toolbar 

3. Viewer Panel – see Viewing Images 

a. Active viewer – see Active Camera 

4. Control Panel – see Control Panel 

a. Group Configuration Tree – see Group Configuration Tree 

b. Screen Layout – see Screen Layout 

c. Zoom Thumbnail – see Zoom Thumbnail 

5. Status Bar – see Status Bar 

a. System Capacity Widgets – see System Capacity Panel 

b. Active Camera name and status – see Status Bar 

 

4.3 Initialization 
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After logging into the SecureGuard™ Client, the user must configure the information that will be shown.  

This information normally needs to be specified only once by each user.  

In addition to all general functions, for the Administrator login ONLY, the Configuration Tool may be 

launched directly using the “gears” icon on the tool bar, or by navigating to “Settings->Server…” from 

the action menu.  These convenient access points are not provided to any other users. 

The tool bar for the admin is shown below:  

 

Figure 19 – Administrator Main Menu and Toolbar 

 

This is the tool bar shown for all other users.  (Notice there is no access icon for the Configuration Tool.) 

 

Figure 20 –Main Menu and Toolbar for all other users 

The items in the top-level menu are: 

1. File 

2. Control 

3. Utilities 

4. Settings 

5. Screen Mode 

6. View 

7. Help 

4.4 User Settings 

Click on the “Person” icon to configure sites and elements for this user environment if this has not been 

previously done.  The information below may also be accessed through the “Settings” menu action. 

4.4.1 Group Management 

Site connections are first configured by the Administrator within the Configuration Tool. Individual users 

may then configure groups, or sets of sites, for viewing. 

A sample dialog is shown below. 
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Figure 21 - Group Management 

4.4.1.1 Group Maintenance 

Sites that have been configured for use within the Configuration Tool will appear in the left panel of the 

dialog.  Use the buttons provided to build groups for display in the right panel of the dialog.  The 

following operations are available: 

1. Create - An initial group with the name ‘Group’ is provided. To create a new group, press the 

New button in the Groups panel on the right side of the dialog. Group names must be unique. 

2. Add a site – First click a destination Group from the list on the right.  Then, click a site in the 

Sites list in the left panel and the “>>>” button. 

3. Remove a site – Select a site within the Groups list on the right then click the “<<<” button. 

The following additional functions can be accessed by right-clicking on a Group name: 

• New Group  

• Rename Group  

• Delete Group – You will be asked to verify this action before it is completed 

• Connect to Group – Selects this group for display and returns to the Client 

 

4.4.2 File Paths  

The File Path Settings dialog can be used to specify where different types of information are stored.  
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Figure 22 - File Paths 

The following information can be provided: 

• Snapshot Path - identifies where snapshot files will be stored. Use the Browse button to select 

the desired path.  

• Export path - identifies the default folder to store recordings extracted from the database. Use 

the Browse button to select the desired path.  

• Snapshot Type – identifies the format that Snapshot images will be stored in.  The types 

available are: 

1. BMP – uncompressed proprietary format invented by Microsoft 

2. JPG – compressed image format developed by Joint Photographic Experts Group 

optimized for photographs. 

3. TIFF – uncompressed image format which preserves all the original information. Useful 

if more processing will be done since it preserves all the original information. 

4.4.3 Image Annotations 

When images from IP cameras, DVRs, and NVRs are viewed, they can be annotated with information 

that identifies the time, site name and camera name. The Image Annotations settings are used to select 

which annotations should appear, and applies these selections to all images displayed. 
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Figure 23 - Image Annotations 

Examples of each type of annotation appear below. 

 

Figure 24 - Image with no Annotations 
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Figure 25 – Image with Site Name annotation 

 

Figure 26 - Image with Site and Camera Name annotations 

 

Figure 27 - Image with Site, Camera Name and Time annotations 
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4.4.4 Events 

The Events dialog configures the display to change to full-screen mode when events are detected.   

 

4.4.5 Sequence  

The Sequence dialog is used to specify a way of cycling through a list of images.   An example of this 

dialog is shown below. 
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Figure 28 - Sequence 

4.4.5.1 Sequence Maintenance 

All configured sites will appear in the left panel of the dialog.  Use the buttons provided to build a 

viewing Sequence in the right panel.  The following operations are available: 

1. Add – To include a camera in the Sequence, click the camera then the Add button. 

2. Remove All – To clear all cameras from the Sequence, click Remove All. 

To order the Sequence list, click on a camera and use the Remove, Up and/or Down buttons to position 

it where desired. 

When a Sequence is activated in the Client, images from the sequence list are cycled through and 

displayed in the Screen Mode selected. Each set of images is shown for a specified period of time or 

Dwell Time. When the dwell time expires, the viewer panel is filled with the next set of images from the 

list. This continues until the list is completed at which time images from the front of the list are shown 

again.  

Note that a single camera can be in the Sequence list multiple times. 
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4.5 Main Toolbar 

The main toolbar is located directly below the Main Menu.  

 

Figure 29 - Main Toolbar 

Starting from the left, each icon is described below: 

1. Site Settings:  (admin ONLY) This button launches the Configuration Tool  

2. User Settings: This button brings up a dialog to configure the User environment 

3. PC Playback: This button brings up a dialog to Playback locally stored recordings. 

4. Export:  This button will browse to the Export folder defined in User Settings /File Paths. 

5. Lock: This button asks the user for the password and then locks the controls of the Client until it 

is unlocked. While locked, images continue to update. 

The buttons on the right-side of the toolbar depend on the mode of the currently selected camera. 

These buttons include: 

1. Live: Use this button to start displaying live images from the currently selected site. This 

button is shown when the current camera is in Playback mode. 

2. Playback: Use this button to select playback parameters and start playback from a remote 

(DVR, NVR, or IP Camera) site. This button only appears if the currently selected site is in Live 

mode. 

3. Record: Use this button to start/stop local recording of the currently selected site. When the 

site is in Record mode, the red dot on the button will flash. This button only appears if the 

current site is in Live mode. 

4. Snapshot: This button will capture the current image on the selected camera and record it on 

the host system. The location of the saved snapshot is specified in the Settings->File Paths. 

5. Audio:  This button enables audio to be heard for the selected site when available. 

4.5.1 File 

In addition to shortcut icons on the toolbar, the application also provides easily accessible menus for 

common functions.  The File menu contains the following options: 

1. Open Group 

The “Open Group …” item lets the user select a display group for viewing. Once selected, the sites in the 

current group will be disconnected and the sites in the newly selected group will be connected. You will 

be asked for verification before this action is started. 
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An example of the group selection dialog is shown below. 

 

           

Figure 30 - Open Group dialog 

2. Connect All Sites - If the group of Sites selected are not initially connected, select this option 

to initiate connections.  

3. Disconnect All Sites – To discontinue viewing a Group, select this option to disconnect. 

4. Exit – This action will save the current settings and exit the application. 

4.5.2 Control 

The Control sub-menu contains actions that are determined by the mode of a selected site.   They 

include: 

1. Remote Playback – Available for DVR and NVR sites, and IP cameras with SD card storage 

2. PC Playback – Available when the selected site is in Live mode 

3. Export – Pops up a file browser for the Export area defined in Settings/File Paths 

4. Record – Starts/stops users recording on a selected site 

5. Audio On/Off – Turns audio on/off for the selected site when available 

Additional functions provided during Playback Mode only: 

• Decrease Speed 

• Pause/Play 

• Increase Speed 

4.5.3 Utilities 

The Utilities menu actions provide access to various utilities and include: 
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1. Snapshot – captures the current image for a camera and stores it in a file. 

2. Lock – locks the CMS program so users cannot make inadvertent changes. 

4.5.4 Settings 

The Settings menu gives easy access to the Settings dialog. Clicking the individual sub-menu items will 

cause the Settings dialog to be opened at the indicated tab.  (e.g. Group Management or File Paths) See 

Section 4.4 User Settings for further information.    

4.5.5 Screen Mode 

The Screen Mode menu provides alternative layouts and display mechanisms for the viewer panel.  The 

following options are available: 

• Simple – Allows the user to choose 8 simple display grid patterns ranging from 1x1 up to 8x8. 

• Advanced – Allows for more complex layouts symbolized by an icon and word description 

• Favorites – Switch between stored, named layout patterns and camera combinations  

• Sequence – Provides a method for activating a predefined Sequence list of images. 

4.5.6 View 

The View menu offers several actions which control the visibility of different portions of the application. 

With these actions, the user can do the following: 

• Hide or show the Toolbar. By default, this is near the top of the main window. It can be 

detached from the main window if desired. 

• Hide or show the Control Panel. This is shown on the left hand side by default.  It can be floated 

or moved to the right side. 

• Hide or show the Status bar. This is shown at the bottom of the main window. 

• Hide or show the Dome Control. This is shown on the right hand side by default. It can be 

floated or moved to the left side. 

• Hide or show the Favorites tool bar.  By default, this appears as part of the main Toolbar, but it 

can be detached from the main window if desired. 

• Hide or show the Debug Log. This is not a modal dialog. After using this action to show the 

Debug Log, the text of the action changes to Hide Debug Log.  

• Open the Activity Log. The Activity Log is modal and will need to be closed before other activities 

can be performed. 

• Full Screen is a toggle to and from full-screen mode.  The menu item is checked when in full-

screen mode. 

4.5.7 Help 

The Help menu gives information about SecureGuard™ and Qt, which is the graphics package used to 

implement the software.   See Help About for examples of the information shown.  
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4.6 Control Panel 

The Control Panel is the collection of controls normally located on the left side of the screen. The panel 

can be moved to the right side or even made to float without being attached to the rest of the window. 

The different parts of the control panel include: 

1. Group Configuration Tree which shows the sites in the group which is currently connected. 

2. Favorites Tree which shows stored screen mode layout/site combinations. 

3. Screen Mode layout selection buttons. This controls the size and arrangement of viewing ports 

in the main viewer panel. 

4. Zoom thumbnail. This area shows the overview of an image when the local zoom functions are 

being used. See Host-Zoom control for more information. 

 Screen snapshots below show alternate docking positions: 

 

Figure 31 - Control Panel (docked on left) 
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Figure 32 - Control Panel (docked on right) 

4.6.1 Group Configuration Tree 

The Group Configuration Tree is in the top part of the Control Panel. An example is shown below. 

 

Figure 33- Group Configuration Tree 

The tree shows the sites and cameras that are in the currently connected group. The Group name is 

shown on the top bar, and each site is shown as an item on the tree. If the Site is connected, its shown 

with a green icon. If the site is disconnected, it will have a red icon. The expansion of a site shows the 

cameras connected to the site, with the names of the cameras specified by the DVR, NVR, or IP camera. 

There are two icons used to depict the different kinds of cameras. The icons used are shown in Table 3: 
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Table 3 - Group Configuration Tree, Camera Icons 

 

This icon is used to represent cameras that do not have pan-tilt-zoom control. (PTZ) 

 

This icon is used to represent cameras that do have pan-tilt-zoom control. For these 

cameras, the dome control will become enabled. 

 

4.6.1.1 Site Context Menu 

If a site is selected in the tree, then the right-mouse button can be pressed to show a site-specific 

context menu. 

 

Figure 34 - Site Context Menu 

The Disconnect action is shown if the site is connected. This action will cause the Client to disconnect 

from the specified site.  

 

Figure 35 - Disconnected Site 
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The Live, Playback, and Start Record of Site are the same as with the main menu and toolbar buttons. 

The checkmark shows which mode the site is currently in. Note that the mode applies to all cameras in 

the site. The Live mode means the cameras are showing live images of what is currently happening. The 

Playback button refers to remote playback where the remote site (at the DVR, NVR, or IP camera) is 

playing back images that were recorded earlier. All cameras at the site are put into playback mode at the 

same time. Recording of a site means capturing the live images from a site and storing them in files. 

Images from a site with multiple cameras are recorded together so that they can be played back as a set. 

You cannot enter Record mode unless the site is in Live mode. If the site is in Playback, then you will 

have to first switch to Live and then switch to Record mode. 

4.6.1.2 Camera Context Menu 

Selecting a camera in the configuration tree and pressing the right-mouse button brings up a camera 

context menu. An example is shown below: 

 

Figure 36 - Camera menu 

The Live, Playback, and Record items apply to the parent site and are the same as actions in the site 

context menu. 

The Camera Info action displays a dialog box with information about the camera. An example is shown 

below. 
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Figure 37 - Camera Information 

The information includes: 

1. Site Name:   the name of the site as specified in the group configuration tree. 

2. Channel Name:   the name of the camera as specified by the remote site. 

3. Format:   the format of the video information coming from the site. 

4. Video Size:   the size of the image in pixels. 

5. Frame Rate:   the approximate rate at which new frames are being received from the site. 

6. Audio Bytes/Sec:   the approximate bytes per second of audio information that are being 

received from the camera. 

4.6.2 Favorites Tree 

The Favorites tree is also shown in the top part of the Control Panel.  An example is shown below. 

 

This tree shows the layout/site combinations that have been saved by the user for the selected group. 

The Favorite name is provided, along with its associated sites.  Click and drag the Favorite name to select 

it for viewing, or right-click for more options. 
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• Show selects this Favorite for viewing 

• Save saves the current layout and site selections into this Favorite name 

• Rename updates the name of the chosen Favorite.  

• Delete removes the Favorite 

 

4.6.3 Screen Mode Layout 

The screen mode layout portion of the Control Panel offers convenient buttons to change the layout of 

the viewing panel. There are two sets of layouts. The first set offers regular grids with uniform viewing 

area and the number of columns the same as the number of rows.  The second set of layout options 

offers a mix of smaller and larger viewing areas. The icons on the buttons show a small version of the 

mix of viewing areas for each option.   These viewer panel controls are shown below. 

 

 

Figure 38 - Screen Mode (Simple) 
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Figure 39 - Screen Mode (Advanced) 

4.7 Status Bar 

The Status Bar is at the bottom of the main window and contains 3 different areas. The contents depend 

on the mode of the currently selected camera. The table below shows the possibilities.  

Table 4- Status Bar Icons 

Mode Status bar 

Recording 

 
Live 

 
Playback 

 
 

4.7.1 System Capacity Widgets 

On the right side of the Status Bar, there are three system capacity widgets. The first shows the CPU 

processing load on the current system. The second shows the amount of memory being used. The third 

shows the amount of space used on the drive used to store image recordings. When the mouse is 

hovered over any of the three widgets, a tool-tip is shown with the numeric value and the name of the 

metric being shown. If you double click on the three icons, a dialog appears that shows the three 

widgets and the current capacity information. An example is shown below: 
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Figure 40 - System Capacity dialog 

4.7.2 Camera Site Status 

The button just left of the capacity widget shows the status of the selected camera. The possibilities are: 

Mode Status button 

Live – showing live images 

 
Recording – live mode, recording on PC 

 
Playback – playing a recording 

 
 

4.7.3 Playback Speed Controls 

When a camera is in playback mode, control buttons will appear within the Status Bar.  These buttons 

control the speed and direction of the playback. 

           

Figure 41 - Playback Controls 

Brief descriptions of each button (from left to right) are as follows: 

•  causes the currently playing video to Jump Back in 1-minute increments 

•  Pause the video. When the site is paused, this button becomes the Play button 

•  Play the video at normal speed. 

•  will increase the playback speed of the video in x2 increments 

•  causes the currently playing video to Jump Forward in 1-minute increments 
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4.7.4 Selected Camera Status 

In the toolbar, the text to the left of the site-specific buttons indicates which camera is currently 

selected. The format of the information is shown in Table 5: 

Table 5 - Status Bar Camera Status Fields 

SiteName : ChannelName  

SiteName Name of site as provided in group configuration tree 

ChannelName Name of the camera as provided by the site 

4.8 Viewing Images 

The purpose of SecureGuard™ is to monitor surveillance cameras at different sites. As such, the Viewer 

is the main activity area. This panel has one or more viewing areas to show the images coming from 

different cameras at remote sites.  

A particular image viewer can show 3 kinds of content. 

1. The Speco Technologies logo when the viewer is not associated with a camera.  

2. An image from a connected camera 

3. A gray screen indicating no video from a connected camera. 

4.8.1 Screen Mode 

The layout of the viewing areas is determined by the screen mode as discussed in Screen Mode Layout. 

Screen snapshots showing sample layouts are shown below. 

 

Figure 42- Screen Layout (2x2) 
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Figure 43 - Screen Layout (Advanced, 6 panel) 

4.8.2 Active Viewing Area 

The Active Viewing Area is the currently selected viewing image.  The currently selected viewing image is 

indicated in many different ways. 

1. In the Group Configuration tree of the Control Panel, the currently selected camera 

corresponding to the active viewing area is highlighted. 

2. In the Viewer panel, the currently selected viewing area is highlighted in yellow, red, or green 

depends on display mode. Yellow is used for live, red for recording, and green for playback.  

3. In the Tool Bar, the currently selected camera is named in the text box next to the site specific 

buttons on the right of the tool-bar. 

You can change the selected camera image by clicking on a camera in the Control Panel or by clicking the 

mouse on the desired image. 

Note that it is possible to have the same camera in multiple viewing areas. If a camera is selected in the 

control panel, the first viewing area with that camera will be selected. 

The Active Camera determines all of the following: 

1. Which viewing area is affected by various viewing area actions 

2. Which camera is affected by camera level actions 

3. Which site is affected by site level actions 
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4.8.3 Dragging Images into viewers 

To populate the image viewers, you can drag items from the Group Configuration Tree into the viewing 

areas. Dragging a site and dropping it into a particular viewer drops all cameras for a site into the 

viewing areas starting with the drop location.  

4.8.4 Moving images  

In addition to dragging from the Group Configuration Tree, images can be moved from one viewer to 

another. Images cannot be moved when the images are zoomed.  Once zooming starts, the mouse 

actions used for dragging drive a panning operation instead.  

4.8.5 Removing images 

To remove an association between a camera and a viewing area, use the Remove action on the context 

menu of the viewing area. Remove All can be used to remove the images from all the viewing areas. 

 

Figure 44 - View context menu 

4.8.6 Ordering images 

To reorder all the images, use the Reorder action on any of the viewing areas. This will put the first 

camera of the first site into the first viewing area etc. 

4.8.7 Quick Zoom Image 

To do a quick zoom of a viewing area, double-click it with the mouse. This changes the screen layout to 

1x1, showing a single view pane. Double-clicking again will return to the original screen layout. 
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4.8.8 Image Annotations 

The image annotations regarding the date/time and camera and site name can be controlled by the 

global settings “Image Annotations” as discussed in Image Annotations. Other annotations are used 

depending on the mode and other actions taken. See Table 6. 

Table 6 - Image Annotation Color Chart 

Yellow text Yellow text is used for images in live mode 

Red text Red text is used for images in record mode 

Green text Green text is used for images in playback mode 

Zoom Xn Zoom factor indication. The text is yellow, green, or red depending on the mode. 

The number after the x indicates the zoom factor. When the zoom factor is one, 

zoom is not on and no text is shown. The zoom factor can vary from 1 to 7 in half-

step increments.  

 

In addition to these annotations, visual indicators are provided when viewing Live images to inform the 

user of event and recording states for individual cameras. Status icons will be shown in the upper right 

corner of the image pane as defined in Table 7 below. 

Table 7 - Visual Indicator Chart 

 
Alarm event has occurred 

 
Alarm event is being recorded 

 

Audio recording is ON 

 
Audio enabled 

 

Continuous recording is ON  

 

Motion event has occurred 

 

Motion event is being recorded 

 

User recording is ON 

 

4.8.9 Camera Information 

The context menu for an image includes a Camera Info action that displays the same camera 

information available from the camera context menu in the Control Panel. See Camera Context Menu 

for an example. 

4.8.10 Host-Zoom control 

The zoom control feature provides a way to enlarge an area of an image.   Below is a sample of this 

capability. 
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Figure 45 - Zoom controls 

The zoomed image is shown within the yellow highlighted box with a “Zoom x2.5” annotation in the 

lower right.  The thumbnail image (to the left) shows the original image with the zoomed portion 

highlighted with a red rectangle.  Beneath this thumbnail image the Site Name and Camera Name are 

shown, along with a zoom slider for increasing/decreasing magnification.  Moving the indicator changes 

the zoom factor. The hash mark at the far left corresponds to a zoom factor of 1 which equates to no 

zooming. Each hash mark corresponds to a half step of zoom factor. 

4.8.10.1 Wheel-based zoom 

Another way to control the zoom factor is to click on an image and then move the mouse wheel. Moving 

the wheel forwards increases the zoom factor a half step for each wheel increment. Moving the wheel 

backwards decreases the zoom factor a half step. The zoom factor can range from 1 to 7. When the 

zoom factor is 1, zooming is off. 

Note that when zooming is on (i.e. zoom factor is not 1), then the viewing area cannot be dragged to 

another viewing area nor can a different camera be dropped into this viewing area. 

When the mouse wheel is used to increase the zoom factor, the location of the mouse is important. As 

the zoom factor is increased, the point in the image that is being pointed to by the mouse will be 

stationary relative to the image viewing area. This gives the visual effect of zooming in on the position or 

object being pointed to. 

4.8.10.2 Image Panning 

When zooming is in effect, you can pan the image in order to show a different portion of the image in 

the image viewing area. One way to pan is to point to the image viewing area, press the left mouse 

button, and then drag the mouse. As this is done, the point in the image that is clicked on will follow the 

mouse and cause a different portion of the image to be shown. This will update the red rectangle in the 

thumbnail, moving it to show the part of the image in the viewer. 

4.8.10.3 Thumbnail image panning 

An alternative way to pan is to point the mouse in the zoom thumbnail image, press the left mouse 

button, and then drag the mouse. As this is done, the red rectangle will follow the mouse and cause a 

different portion of the image to be shown in the viewer. 
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4.8.10.4 Thumbnail zoom slider control 

The slider control in the zoom thumbnail area of the control panel can be used to increase or decrease 

the zoom factor.  When the slider is used, the “focus” or “stationary” point of the image may or may not 

be clearly defined. If the image viewer was made the active area through a mouse click on the viewing 

area, then the location of the mouse at the time of the click will be the image location centered on 

during zooming. If the active area was instead selected by clicking on a camera name in the control 

panel, then the center of the image will be used as the focus point. 

4.8.11 Adjust Image Qualities 

To adjust image quality, select it, then right-click.  The dialog below will be presented. 

 

Figure 46 - Adjust Image dialog 

The image qualities available to be adjusted are: 

1. Brightness 

2. Contrast 

3. Saturation 

4. Hue 

5. Sharpness 
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Each quality is on a scale of -128 to +127 and by default, all images start with a value of 0. As values are 

modified, the viewing area will update to show the effects of the change. The controls available are: 

1. Slider - Move the slider to the left to make the value smaller, or right to make the value larger. 

2. Spin control - Use the up and down arrows to increment or decrement the values for each 

3. Reset - Reset all qualities back to the default of 0. 

4. OK – saves updates and dismisses the dialog. 

5. Cancel - to return to the image quality values which were in effect when the dialog was started. 

Note that the image quality values are not saved upon exit of the application. 

4.8.12 Pan-Tilt-Zoom Control 

In the right-mouse context menu, the Dome Control action is enabled if the associated camera has Pan-

Tilt-Zoom (PTZ) capability.  When the action is selected, the Dome Control Panel is opened and becomes 

visible.  

4.8.12.1 Controlling PTZ cameras with the Dome Control Panel 

The exact content of the PTZ panel depends on the capabilities of the actual camera and the site it is 

connected to.  A sample of the dome control for a camera connected to an RS model DVR is shown 

below. 
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Figure 47 - Dome Control (RS Model) 

The following functions are available: 

• Move the Camera – use the arrow buttons to move the camera in 8 different directions 

• Focus – update for Near (+) or Far (-)  focus 

• Iris - Open the Iris(+) or close the iris(-) for brightness 

• Zoom – Zoom in (+) or out (-) 

• Go Preset - Changes the camera settings to previously stored settings. The number of presets 

may vary for each camera 

• Set Preset - Captures the current state of the camera position and saves the settings in the 

designated preset. If Go Preset is requested later with this preset number, the camera will 

return to these settings. 

 

4.8.12.2 Using the mouse to control PTZ abilities 

When the dome control is open and the current image is a PTZ-capable camera, the mouse may also be 

used to affect the camera position and settings. 
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When the mouse is in the viewing area, the mouse icon will reflect what area of the screen the mouse is 

in.  For example, in the upper left corner, the mouse icon may point in the northwest direction. Pressing 

the mouse button will cause the camera to point northwest.  

To zoom the camera, use the mouse wheel. This operates similar to the host-based zoom discussed 

earlier, but physically affects the camera not just the image in the Viewer. 

There is a “sweet” spot in the center of the image viewing area where double-click can be used for the 

quick zoom feature. Pressing the mouse in the sweet spot can also start a drag and drop of the camera 

image to move it to another viewing area. 

When the dome control is open, use of the mouse wheel in the image viewer changes the zoom on the 

camera. When the dome control is not open, the mouse wheel controls the zoom factor as implemented 

in the Viewer. 

4.8.13 Image Sequencing 

A Sequence is defined in Sequence Settings. The sequence can be run by selecting the menu item Screen 

Mode->Sequence or by selecting the Sequence viewing tab on the Viewer.  

When no images have been selected, the Sequence viewing tab appears as shown below. 

 

Figure 48 - Initial Sequence tab 

Use the Settings->Sequence tab to add views to the sequence. The checkbox can be used to start/stop 

the sequence. An example of an activated Sequence is shown below.  
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Figure 49 - Active Sequence tab 

The Sequence viewing tab shows a dwell countdown so you know how many seconds are left to view 

the current page of images.  The sequence can be stopped by unchecking the menu item Screen Mode-

>Sequence or the checkbox on the Sequence tab itself. 

4.9 Recording Images  

Images are recorded in two ways:  through Scheduled recording set up in the Configuration Tool and 

through User Recording, initiated by use of the Record capability when a site is streaming Live images.  

User Recording will change the display text to red and add a red dot in the upper right corner of the 

viewing area.   To discontinue User recording, press the flashing Record button again. 
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Figure 50 - View in Record Mode 

4.10 Playing Recordings 

To play previously recorded images, select the Control->PC Playback action or use the Playback button 

 on the toolbar.   The Playback dialog will be presented to choose the site(s) and start time to begin 

playback.  

 

Figure 51 - Playback dialog (Search by Time) 

4.10.1 Recording Date 

The calendar days highlighted in yellow indicate those that have available recordings.  (The selected day 

is shown with a gray background.)  Click to select another date if desired.  The tabbed display on the 

right shows the recordings available for the day chosen.   Use the slider bar at the bottom to pick a Start 

Time for the group or use the entry box to fine-tune the start time for precision that may be difficult to 
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control with the slider.  Users may also click within the time grid itself to select a time and site of 

interest. 

4.10.2 Recording Type 

Filter the list of recording results that are shown by checking any of the available types: 

• Continuous  

• Motion 

• Sensor 

• User 

The first three options are recordings managed by the Schedule function of the Configuration Tool.   

User recordings are events recorded manually by any user through use of the Record function within the 

SecureGuard™ Client.   The color Yellow is used on the display when recordings for multiple channels are 

available, or the recording type is Unknown.  

4.10.3 Site Selection 

The current group is shown in the tree on the left.  Use the checkboxes here to filter the site and 

channel data that will be provided in the Search by Time and Search by Event tabbed displays at right.  

The Select/Clear All button can be used for group actions.   The site(s) selected will be the ones shown 

during Playback.  Likewise, a site can be selected by clicking within the time grid. 

When Playback is active, the site(s) show recorded images in a special layout.  The text annotations will 

be in Green text to indicate playback mode. Additional playback control buttons will be shown in the 

Status bar. 

4.10.4 Search Types 

There are three ways to search for recordings and select a start time for Playback.  These are described 

below.   The tabbed views of the recording data can be filtered based on Recording Type and desired 

Sites, which are checked in the list along the left part of the display.   All selected sites will be viewed 

when going into Playback. 

4.10.4.1 Time Based Search 

Upon initialization, a color-coded time grid will be shown to the right of the Playback Sites list, indicating 

which hour-blocks contain recordings (see Figure 51).   Sites and channels are provided according to user 

selections in the tree on the left.   Click on an Hour or a cell in the time grid to set playback start time to 

the nearest hour.   Press Playback to begin viewing recordings.  Video will begin playing with the first 

available recording(s) on or after the time selected. 

4.10.4.2 Event Based Search 

Specific recordings may also be located by clicking the Search by Event tab to see a list of recorded 

events for the selected sites on the given day.   An example of this format is shown below. 
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Figure 52 - Playback dialog (Search by Event) 

Each column of data may be sorted by clicking the column header.  Single-click on an Event to use the 

event’s Start time as the playback start time for all Sites;   Choose the sites/channels from the Playback 

Site list and press Playback to continue, or double-click on an Event to go directly into Playback mode. 

4.10.4.3 EZ Search 

A powerful tool within SecureGuard™ is the ability to search an array of snapshots occurring over a 

period of time to find an exact time to begin Playback.   This function can be accessed from both the 

Search by Time and Search by Event tabs.  Within the Search by Time tab, select the Site you wish to EZ 

Search in.  When using the Search by Events tab, click on the Event listed and the Site will be selected for 

you. 

The first dialog presented in EZ Search will show one snapshot from each hour of the 24 hour day.  This 

is used to narrow in on the general time of interest.   An example of the 24-hour time grid is shown 

below. 



SecureGuard™  

 Page 56 12/28/2015      

 v1.2 

 

Figure 53 - EZ Search 24-Hour selection grid 
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Double click an image to expand a single hour into 2 ½ minute snapshots, shown below. 

 

Figure 54 - EZ Search 2.5 Minute selection grid 
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Double click on the desired frame to set the Playback Start Time to this timestamp and begin Playback. 

An example of the Client performing multi-site Playback is shown in the annotated figure below. 

 

Figure 55 - Playback mode 

Once a camera view has been selected, a multi-functional control panel will appear at the bottom of the 

display to provide finer grain controls for playback. 

Features of the playback dialog are as follows: 

• JB/JF – Jump all recordings back/ahead 1 minute 

• Play/Pause – Play or Pause the recordings 

• Fast Forward – Increase playback speed, up to 32x.  

• Time Span – Use the slider bar to adjust the granularity of the time grid shown on the right 

• Jump to Last/Next Recording file – changes the current playback time to jump to last/next 

recording file;  This feature is helpful when playing back short recordings which typically occur 

with Motion and Sensor triggered activity 

The user may also use the cursor to drag the time grid under the Current Playback Time, effectively 

selecting the playback time on the fly, graphically.   Although the time grid provides recording detail for 

only the selected site, changing the current playback time affects all sites shown in the playback layout.  
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When Playback is complete, click the Live icon to return to live video.   Alternatively, click the PC 

Playback icon to find another recording for Playback. 

 

4.11 Playing Images Recorded Remotely 

 

DVR, NVR, and IP camera sites may have the capability to make local recordings separate from those of 

the Schedule manager.  When the Control->Remote Playback or the Playback button on the toolbar is 

selected, the dialog below is shown.  This dialog is used to select a time to start playing back video that 

has been recorded at the site. 

 

Figure 56 - Remote Playback dialog 

The current group is shown in the tree on the left.   Use this tree to filter the site and channel data that 

will be provided in the tabbed display at right.  For Remote Playback, only one site may be selected at a 

time.  Select the site to use as the source for remote playback by clicking the box next to it.   The EZ 

Search button can be used to refine start time by exploring recordings on individual channels. 

The Search by Event tab for Remote Playback contains any recording metadata that can be extracted 

from the site itself. 
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Figure 57 - Remote Playback Search by Event tab 

 

4.12 Exporting Recordings 

When in Playback mode, users can Export recordings from the system. Controls for this feature will 

appear on the right side of the main tool bar after clicking a video in Playback mode.  These controls are 

circled in red in the figure below. 
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Figure 58 - Export controls 

While the video plays, users review the images and select start and end times for the segment that will 

be exported.  The buttons provided on the tool bar function as follows: 

•   selects a Start time 

•  selects a Stop time 

•  launches the Export dialog shown below 
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           Figure 59 - Export dialog 

Adjust start and end times as needed.  Browse to select a destination folder, or use the default provided 

in the User Settings dialog.  Select the desired file format from the options provided and click Export to 

begin the operation. 

 

4.13 Playing Exported Recordings 

Once video is exported, SecureGuard™ has its own video player to view saved recordings offline.   To 

access this feature, select the SecureGuard Player from the options shown under Speco 

Technologies/SecureGuard in your program menu.  (Users may also navigate to the location where 

exported video is stored and launch the player by right-clicking and selecting “Open With…” ). 

  

Figure 60 – Launching the SecureGuard Player 
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Select Open Export.   Folders shown are named using Site Name and export time.  Find the desired video 

and click to open the folder.  Open the .mst file shown to load all cameras recorded at the device for 

simultaneous play.   To review video from individual cameras, select Open File from the toolbar and 

choose from the files shown. 

Additional controls along the toolbar are as follows: 

•  Settings –Set the destination folder for image snapshots here. 

•  Print – Abilities to copy and print images are provided. 

•  Snapshot – Save a snapshot of the current video. 

•   Layouts – As with the SecureGuard application, assorted layout options are provided. 

•  Full Screen – Show the player in full screen mode. 

 

                         

 

Figure 61  - SecureGuard Player 

Use the playback control buttons to review the exported video:  
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•  will rewind the video in x2 increments 

•  causes the currently playing video to Jump Back in 1-minute increments 

•  Pause the video. When the site is paused, this button becomes the Play button 

•  Play the video at normal speed.  

•  causes the currently playing video to Jump Forward in 1-minute increments 

•  will increase the playback speed of the video in x2 increments 

•  if audio has been recorded, this button will provide volume control for the selected image. 

 

4.14 Making an image snapshot 

To make a snapshot of an image, select the desired image and then press the snapshot button or use 

the image context-menu item “Take Snapshot”.  When the snapshot is taken, a temporary message is 

written in the lower-left of the Status bar that indicates where the snapshot was saved.  

 

Figure 62 - Snapshot Status Bar message 

The snapshot includes the image and date and time annotations. An example is shown below. 
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Figure 63 - Sample Snapshot 

4.15 Help About 

The Help About box shows the version and build date of the product. A separate page displays the 

license and copyright information for Qt. 

4.16 Activity Log 

An activity log is kept to record high-level actions that affect the SecureGuard™ configuration or the 

settings on a particular IP camera, DVR, or NVR. The log can be viewed to review recent activity. The 

activity log can be viewed by using View-> Activity Log from the main menu. This brings up a modal 

dialog box as shown below. 
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Figure 64 - Activity Log 

The columns shown include the following information: 

1. Time: This is the clock time to the nearest millisecond. 

2. User: This is the name of the logged in user and the name of the instance being used at the time. 

3. Activity: This is a brief description of the activity being logged.  

Initially, the log shows the most recent activity. It is possible to browse to other days and see activity 

from previous sessions.  The following navigation operations are available: 

1. Press the Save button to save the activity for this day to a file of your choosing. 

2. Press the << button to show the activity on the day previous to the day being shown. 

3. Press the >> button to show the activity on the day after the day being shown. 

4. Press the Search button to show a calendar that can be used to browse to a particular day of 

activity. An example is shown below. 



SecureGuard™  

 Page 67 12/28/2015      

 v1.2 

  

Figure 65 - Activity Log with Date dialog 

The available controls are: 

1. <- to move to the previous month. 

2. -> to move to the next month. 

3. The dates highlighted in yellow are dates on which activity has been logged. 

4. The shaded day indicates the currently selected day. 

5. Pressing the arrow by the name of the month causes a drop-down list with all the month 

names to be shown to allow selection of the desired month. 

6. Pressing the year causes the year to become a spin-box control such that the year can be 

increased or decreased, as shown below. 
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Figure 66 - Activity Log with Year selection 

7. Press the Cancel button to keep the originally chosen date. 

8. Press the OK button to switch to the newly chosen date. 

4.17 Debug Log 

The Debug Log records low-level information regarding communications with DVRs, NVRs, and IP 

cameras. This information may be useful in different support scenarios.  

The log can be viewed by selecting View->Show Debug Log from the main menu. When the log is being 

shown, the menu item will be Hide Debug Log instead of Show Debug Log. An example is shown below. 

 

Figure 67 - Debug Log 
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This window is not modal, so you can open the dialog and leave it up while you do other activities. 

Unlike the activity log, this information is not kept across sessions.  The information in the view contains 

the following columns: 

1. Date and time. The time is shown in milliseconds. 

2. Information. Each line will identify the action being logged. The lines are usually about low-level 

communications with a DVR, NVR, or IP camera. They can also be status lines in general. 

The buttons and actions available in the dialog box include: 

1. Save. The contents of the debug log window can be saved to a text file. 

2. Copy. The contents of the debug log window can be copied to the clipboard. 

3. Max lines. The maximum number of lines to show in the debug log can be changed from the 

default of 1000. 

4. Clear. Pressing the clear button clears the debug log. 

5. Close. Pressing the x icon or selecting View->Hide Debug Log causes the debug log view to close 

and not be visible anymore. Log messages continue to be logged and can be viewed at a later 

time. 


